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Introduction	
  
Protégé Desktop 4.3 (also referred to here as Protégé) is an open source graphical tool, created by 
Stanford University, for viewing and editing ontologies.  
 
Oracle Spatial and Graph RDF Semantic Graph support for Protégé Desktop 4.3 (also referred to here as 
support for Protégé) provides the ability to view and edit ontologies in Oracle Database with Protégé 
Desktop. It implements a plugin that conforms to the Protégé-OWL 4.x plugin architecture, as described 
in the Protégé 4 Developer Documentation. It replaces the University of Manchester OWLAPI that is 
distributed with Protégé Desktop 4.3 to enable the support for Protégé.  
 
Installing support for Protégé adds an Oracle menu to the Protégé menu bar. The menu items execute 
RDF Semantic Graph operations on one or more ontologies of interest stored in Oracle Database RDF 
graph store.  
 
For information about Protégé Desktop, including links to documentation and download instructions see 
http://protege.stanford.edu/products.php - desktop-protege.  
	
  

Prerequisites	
  to	
  install	
  support	
  for	
  Protégé	
  	
  
■  Oracle Database 12c Release 1 (12.1.0.1 or higher). Oracle Database 11g Release 2 (11.2.0.3 or 

higher) is also supported.  

■  Oracle JDK6 or JDK7 
■  Protégé Desktop 4.3 

 

	
  

	
   Installing	
  support	
  for	
  Protégé	
  on	
  Windows	
  
www.oracle.com	
  
Oracle	
  Spatial	
  and	
  Graph	
  

	
  

Objective	
  
This document describes how to install Protégé Desktop 4.3 (also referred to here as Protégé), enable 
Graph RDF Semantic Graph support for Protégé (also referred to here as support for Protégé) and use 
Protégé to operate on ontologies stored in Oracle Database.	
  
	
  

Installing	
  Protégé	
  Desktop	
  
Assuming the Protégé Desktop 4.3 installer is available on your local disk, when running the installer 
under Windows, you will be asked for permission to start the Protégé InstallAnywhere wizard. Click Yes. 
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The installation wizard will guide you step by step in order to select the installation folder, create 
shortcuts and choose the Java VM to run Protégé. 
 

 
Protégé	
  InstallAnywhere	
  wizard	
  

 
 
 
When installing, there are two important locations to remember that Protégé installer will ask: 
 

1. Location on the hard drive to install Protégé  
2. Location of the Java Runtime Environment you wish to use  

 
When choosing the Java VM you must select version 1.6 or later, and not select the embedded JVM.  
Choosing other versions of the Java VM may cause the plug-in to fail at startup. 
There are known issues under Windows in which the embedded Java VM may fail to run Protégé. 
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Java	
  VM	
  Selection	
  Step	
  

 
Once the installation finishes, you will see a success message and the location of the installation as 
follows: 
 

 
Install	
  Complete	
  Step	
  

 

Installing	
  Protégé	
  on	
  Other	
  Operating	
  Systems	
  
Follow the instructions for installing Protégé in your desired operating system, which are located in the 
Documentation link on the download page for Protégé Desktop 4.3. 
JDK 6 or later is recommended. 
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Enabling	
  the	
  support	
  for	
  Protégé	
  

Downloading	
  the	
  Jar	
  Files	
  
The support for Protégé is implemented as a set of jar files. The distribution is available for download 
from Oracle's Support website My Oracle Support (support.oracle.com). 
	
  

Adding	
  the	
  JAR	
  files	
  to	
  Protégé	
  
Once downloaded, the jar files must be added to the plugins folder inside the Protégé installation.  
The files in the installation directory look like following  
	
  

	
  
Protégé	
  for	
  Windows	
  Installation	
  Directory	
  

	
  
The	
  following	
  jar	
  must	
  be	
  replaced	
  -­‐	
  org.semanticweb.owl.owlapi.jar	
  
	
  
The	
  following	
  jar	
  must	
  be	
  added	
  -­‐	
  OraclePlugin.jar	
  
	
  
Inside the folder plugins you will find all the plug-ins that Protégé uses, and to enable support for Protégé 
you need to copy the jar file here and start the app. The folder for the plug-ins looks like the following: 
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Protégé	
  plugins	
  folder	
  

	
  

Executing	
  Protégé	
  on	
  Windows	
  7	
  
On Windows 7, Protégé has an executable file, which is added to the Start menu under All Programs. 
	
  

	
  
	
  

Executing	
  Protégé	
  on	
  Windows	
  8	
  
On Windows 8, Protégé has an executable file, which is added to the	
  Apps	
  view	
  under the Protégé_4.3 
category. 
	
  



10	
  Oracle	
  Spatial	
  and	
  Graph	
  RDF	
  Semantic	
  Graph	
  Developer’s	
  Guide	
  -­‐	
  Support	
  for	
  Ontology	
  Editing	
  with	
  Protégé	
  Desktop	
  
	
  

	
  
	
  

Executing	
  Protégé	
  on	
  Linux	
  Systems	
  
For Linux systems the start script, run.sh, is in the Protégé installation directory. To run this script, type 
sh run.sh using a terminal window as shown below. 
	
  

	
  

Verifying	
  support	
  for	
  Protégé	
  Installation	
  
Once	
  started,	
  you	
  will	
  see	
  information	
  about	
  your	
  platform	
  and	
  a	
  list	
  showing	
  which	
  plug-­‐ins	
  are	
  
enabled.	
  If	
  the	
  support	
  for	
  Protégé	
  was	
  successfully	
  installed	
  in	
  Protégé,	
  the	
  list	
  of	
  plug-­‐ins	
  will	
  
include	
  Oracle	
  Plugin	
  as	
  shown	
  below	
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Once the Protégé application is displayed, the support for Protégé will add Oracle to the menu bar.  
At this point support for Protégé is ready for use. 
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   The	
  Fact++	
  Plug-­‐in	
  
www.oracle.com	
  
Oracle	
  Spatial	
  and	
  Graph	
  

	
  

How	
  to	
  Disable	
  Fact++	
  Plug-­‐in	
  
When running Protégé you may encounter the following message about missing libraries or platforms not 
supported: 

	
  
	
  

	
  
	
  
	
  

In this case, you must delete or remove the uk.ac.manchester.cs.owl.factplusplus.jar file inside the 
plugins folder and restart Protégé. 
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   OpenJDK	
  Warning	
  
www.oracle.com	
  
Oracle	
  Spatial	
  and	
  Graph	
  

	
  

Install	
  Java	
  Runtime	
  from	
  Oracle	
  
When running Protégé you may encounter the following message about OpenJDK Runtime not 
supported: 
	
  

	
  
	
  
In this case, you must install a Java Runtime from: https://java.com/download and set the JAVA_HOME 
variable to point to the newly installed Java Runtime before you restart Protégé. 
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   Using	
  the	
  support	
  for	
  Protégé	
  
www.oracle.com	
  
Oracle	
  Spatial	
  and	
  Graph	
  

	
  
The support for Protégé adds a menu tab with a set of options to Protégé. 
	
  

	
  

	
  
	
  

The	
  Oracle	
  Menu	
  
The main application of Protégé will include a menu with the options Open Database Ontology, Save, 
Save As, Save Reasoner Output, Manage Database Models, Manage Database Entailments and Switch 
Database.  
When an ontology is loaded, the Save option will make an incremental edit that is saved in Oracle 
Database, whereas the Save As option will replace the ontology or create a new one. 
After choosing Save or Save As, a message window will pop up to report weather the ontology was saved 
or if there was an error, as shown below. 
The message may be delayed depending on the size of your ontology, configuration of Oracle Database 
and network speed. 

	
  
	
  

	
  
	
  

	
  
The Save As option displays a menu to choose between overwriting an existing ontology and creating a 
new one in the database. 
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When using the Open Database Ontology option, a dialog will display all the ontologies that the current 
user can load from Oracle Database. After selecting and loading an ontology, the main application will 
display the name of the ontology in the window title bar. 

	
  
	
  

	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
   	
  	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  Loading	
  Ontology	
  Dialog	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  Ontology	
  Name	
  on	
  the	
  Top	
  Border	
  

	
  
	
  

The first time you try to save the ontology you create, the database connection dialog is displayed so that 
you can establish an Oracle Database connection. Once a database connection is successfully established, 
the Save and Save As options allow you to replace an existing ontology or create a new ontology, as 
shown below. 

	
  

	
  	
  	
  	
  	
  	
  	
  	
  	
  	
   	
  	
  
First	
  Time	
  Saving	
  Dialogs	
  –	
  When	
  Saving	
  a	
  Protégé	
  Ontology	
  to	
  the	
  Database	
  



16	
  Oracle	
  Spatial	
  and	
  Graph	
  RDF	
  Semantic	
  Graph	
  Developer’s	
  Guide	
  -­‐	
  Support	
  for	
  Ontology	
  Editing	
  with	
  Protégé	
  Desktop	
  
	
  

Connecting	
  to	
  a	
  Database	
  
From the Oracle menu choose Switch Database, which enables you to input the database connection 
information. 
The following illustrations show tabs for connections to Oracle Database: 

	
  

	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  
	
  
	
  

After inputting the required information to connect to Oracle Database, ontologies can be loaded using 
the Open Database Ontology option. A dialog with all available ontologies for the current users will be 
displayed so that you can choose which ontology to read from and load into Protégé. 
After choosing the ontology, the load time will vary depending on your network connection speed and the 
size of the model. 
There is no data loading progress indicator in Protégé, the application may appear non-responsive while 
the ontology is being loaded. 
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   Using	
  Protégé	
  
www.oracle.com	
  
Oracle	
  Spatial	
  and	
  Graph	
  

	
  
Protégé is a visual editor for the Web Ontology Language. The main application is tab-based with options 
to edit Classes, Object Properties, Data Properties, Individuals and Annotations. 
The support for Protégé provides compatibility with the database by providing conversion between 
Triples and OWL APIs in order for Protégé to be able to exchange information with it. 
	
  

Editing	
  Classes	
  
Once the main application is loaded, the classes can be edited in the Classes tab. All classes are a subclass 
of Thing (owl:Thing) and are selected for editing in the Class hierarchy as shown below. 

	
  
	
  

	
  
	
  
	
  

Here you have the options to add a subclass or sibling class or to remove one. Once a Class is added, you 
can select it to add annotations and descriptions of it.  
The following is an example of how to add a union. 

	
  
	
  

	
  	
  
From	
  the	
  Description	
  Panel,	
  Press	
  the	
  Plus	
  Sign	
  next	
  to	
  Equivalent	
  To	
  for	
  class	
  “A”	
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In	
  the	
  Class	
  Expression	
  Editor,	
  Type	
  “B	
  or	
  C”	
  

	
  

	
  	
   	
  
The	
  Equivalence	
  Will	
  Be	
  Displayed	
  When	
  Selecting	
  The	
  Class	
  “A”	
  

Editing	
  Object	
  Properties	
  
Object properties are edited in the Object Properties tab; as with the classes tab, you will have a hierarchy 
with topObjectProperty as the root of all object properties. 
The following is an example of adding an object property. 
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From	
  the	
  Hierarchy	
  Panel,	
  Select	
  the	
  “topObjectProperty”	
  and	
  Then	
  Press	
  “Add	
  sub	
  property”	
  

	
  

	
  
A	
  Dialog	
  Allows	
  Us	
  to	
  Input	
  the	
  Desired	
  Name	
  for	
  the	
  Object	
  Property	
  

	
  

	
  	
   	
  
Once	
  the	
  Object	
  Property	
  is	
  Added,	
  We	
  Can	
  Edit	
  the	
  Description/Characteristics/Annotations	
  

Editing	
  Individuals	
  
The Individuals tab differs from the rest of the tabs by adding a hierarchy for classes and a members list 
for the individuals. Individuals can belong to a specific class or be part of the Thing class. Once a class is 
selected, you can add/remove individuals from the members by using the Add/Delete buttons as shown 
below. 
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Once an individual is added, you can choose it from the members and edit its description, assertions and 
annotations. 
The following is an example of individuals with Object Property Assertions. 
 

	
  
First	
  Add	
  Two	
  Individuals	
  to	
  the	
  Thing	
  Class	
  

	
  

	
   	
  	
  
On	
  the	
  Property	
  Assertions	
  of	
  One	
  of	
  the	
  Individuals,	
  Press	
  “Object	
  property	
  assertions”	
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An	
  Editor	
  Lets	
  You	
  Choose	
  an	
  “Object	
  Property”	
  and	
  “Individual”	
  to	
  Create	
  the	
  Assertion	
  

	
  

	
  	
   	
  
Once	
  Selected,	
  the	
  Object	
  Property	
  Assertion	
  Will	
  be	
  Displayed	
  in	
  the	
  Assertion	
  Panel	
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Starting	
  a	
  Reasoner	
  
Protégé comes bundled with HermiT and Fact. In order to start, you must select a reasoner from the 
Reasoner menu. 
	
  

	
  	
   	
  
	
  

After selecting the reasoner, you can start the inferencing on the ontology by selecting the Start reasoner 
option from the Reasoner menu as shown below. 
	
  

	
  	
   	
  
	
  
	
  

After the process is completed, the inferred classes and individuals will appear as a highlighted element in 
each of the description panels of their corresponding types. These elements cannot be edited, and you can 
easily access them by selecting the inferred class hierarchy and members list. 
Note that the support for Protégé will not save the inferred elements in the database. 
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Saving	
  Inferred	
  Ontology	
  
To save the inferred ontology, you must select Save Reasoner Output from the Oracle menu. 
You must start a reasoner first in order to save the inference. 
	
  

	
  
	
  
	
  

You will be asked to input a name to save the inference as a new ontology in the database. 
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The process of inferencing is resource-intensive, and can sometime take a long time to complete, 
depending on complexity. Before processing the inference, you will be asked to provide a timeout in 
seconds for the inference process to stop trying to complete the inference when this time is reached 
(setting the timeout to zero means there is no time limit). 
	
  

	
  
	
  

Once the inference process reaches its timeout or completes, a message dialog will be displayed, giving 
feedback about the operation, such as follows: 
	
  

	
  
	
  

If	
  the	
  inference	
  does	
  not	
  complete	
  in	
  the	
  allocated	
  time,	
  the	
  process	
  may	
  be	
  retired	
  with	
  increased	
  
timeout.	
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RDF Semantic Graph supports models and virtual models in Oracle Database. Models store ontologies, 
asserted data and entailments. (See the RDF Semantic Graph Developer’s Guide for details.) The support 
for Protégé can manage and bulk load RDF Semantic Graph models. To do this click Oracle > Manage 
Database Models. 

  
 

The Model Browser has a row for each model in the associated database connection, with the following 
information about each model: Model ID, Model Name, Owner (schema), Name of the RDF application 
table, and whether it is a Virtual Model. You can specify a string to Filter the displayed results, and you 
can click Show All to show all the models. 
The Model Browser has the following menus and menu items: 
■  Options menu: 

–  Update: Updates the display based on the current metadata and data. 

–  Pagination: Specifies the maximum results to be displayed per page. 

■  Edit menu: 

–  Copy: Copies the text from the selected row or rows to the system clipboard. 

–  Copy All: Copies the text from all rows to the system clipboard. 

■  Actions menu: 

–  Drop Model: Drops (deletes) the selected model. To select the model, click in its row. When prompted, confirm that 
you want to delete the selected ontology. 
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For Oracle Database, this action is implemented using the PL/SQL SEM_APIS.DROP_SEM_MODEL procedure. 

–  Empty Model: Truncates the selected model by deleting the data from its RDF application table but not the table 
itself. To select the model, click in its row. When prompted, confirm that you want to truncate the selected ontology.  

For Oracle Database, this action is implemented using the SQL statement TRUNCATE TABLE, which is described in 
Oracle Database SQL Language Reference. 

–  Rename Model: Renames the selected model (not a virtual model). To select the model, click in its row. When 
prompted, specify the new name for the selected ontology. 

For Oracle Database, this action is implemented using the PL/SQL SEM_APIS.RENAME_MODEL procedure. 

–  Create Model: Creates a model that is not a virtual model. If you click Advanced, you can specify the tablespace and 
whether to use basic compression, in addition to the model name. After the model is created, it appears in the Model 
Browser display. 

For Oracle Database, this action is implemented using the PL/SQL SEM_APIS.CREATE_SEM_MODEL procedure. 

–  Create Virtual Model: Creates a virtual model. Specify the models and rulebases to be used in creating the virtual 
model. After clicking Create VM, specify the new name for the new virtual model. After the virtual model is created, 
it appears in the Model Browser display. 

For Oracle Database, this action is implemented using the PL/SQL SEM_APIS.CREATE_VIRTUAL_MODEL 
procedure. 

–  Remove Virtual Model: Drops (deletes) the selected virtual model. To select the virtual model, click in its row. 
When prompted, confirm that you want to delete the selected virtual model. 

For Oracle Database, this action is implemented using the PL/SQL SEM_APIS.DROP_VIRTUAL_MODEL 
procedure. 

–  Load RDF Data: Loads RDF data into the selected model. To select the model, click in its row. Select the tab for 
desired main option: Load Files; Load All Files from Directory; Split, Save & Load; or Save & Load. (The available 
fields depend on the option selected.) 
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Creating	
  Models	
  
To create a model, you must select Create Model from the Actions menu. 
 

 
Model	
  creation.	
  

 
You will be asked to input a name to save the model into the database.  
You will also be given the choice to specify the advanced options.	
  

 

 
Advanced	
  model	
  creation.	
  

 

Empty	
  Models	
  
To empty a model, you must select Empty Model from the Actions menu. 
 

 
 

You	
  will	
  be	
  asked	
  to	
  confirm	
  before	
  truncating	
  the	
  selected	
  model.	
  
 

Delete	
  Models	
  
To delete a model, you must select Drop Model from the Actions menu.	
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You	
  will	
  be	
  asked	
  to	
  confirm	
  before	
  deleting	
  the	
  selected	
  model.	
  

Rename	
  Models	
  
To rename a model, you must select Rename Model from the Actions menu. 
 

	
  
	
  

You	
  will	
  be	
  asked	
  a	
  new	
  name	
  to	
  rename	
  the	
  model.	
  

Create	
  Virtual	
  Models	
  
To create a virtual model, you must select Create Virtual Model from the Actions menu. 

	
  

	
  
	
  

You will be shown a list of all available models and rulebase, which the current user has access to.  
To create the virtual model you must choose the desire models and rulebase by selecting their respective 
checkbox. Selected elements will be display in a list below. 
Regular expressions are supported for the filter. 
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Once you click Create, you will be asked to input a name to save the entailment into the database. 
 

Delete	
  Virtual	
  Models	
  
To delete a virtual model, you must select Remove Virtual Model from the Actions menu. 
 

 
 

You	
  will	
  be	
  asked	
  to	
  confirm	
  before	
  deleting	
  the	
  selected	
  virtual	
  model.	
  
 

Loading	
  RDF	
  Data	
  	
  
To load RDF data into a model, you must select Load RDF Data from the Actions menu. 
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The loader allows the user to Load Files, Load All Files from Directory, Split Save & Load and Split & 
Load. User can choose the option that best fit the loading needs and will be displayed a series of options 
to improve the loading which allows flags, language selection and threads.  
Zip and GZip compressed files are supported. 
 
The loader supports the following formats: 
N-Triple, N-Quad, RDF/XML, OWL/XML, OWL, OWL Manchester, OBBO, KRRS2, TTL and Turtle. 
The auto select option will try all supported formats in order to load. 
	
   	
  



31	
  Oracle	
  Spatial	
  and	
  Graph	
  RDF	
  Semantic	
  Graph	
  Developer’s	
  Guide	
  -­‐	
  Support	
  for	
  Ontology	
  Editing	
  with	
  Protégé	
  Desktop	
  
	
  

	
   Using	
  the	
  Entailment	
  Manager	
  
www.oracle.com	
  
Oracle	
  Spatial	
  and	
  Graph	
  

	
  

	
  
	
  

The Entailment Browser has a row for each entailment in the associated database connection, with the 
following information about each entailment: Entailment Name and Owner (schema). You can specify a 
string to Filter the displayed results, and you can click Show All to show all the entailments. 

The Entailment Browser has the following menus and menu items: 
■  Options menu: 

–  Update: Updates the display based on the current metadata and data. 

–  Pagination: Specifies the maximum results to be displayed per page. 

■  Edit menu: 

–  Copy: Copies the text from the selected row or rows to the system clipboard. 

–  Copy All: Copies the text from all rows to the system clipboard. 

■  Actions menu: 

–  Create Entailment: Creates an entailment. Specify the models and rulebases to be used in creating the entailment. 
After clicking Create, specify the name for the new entailment, and optionally click Advanced for advanced options. 
After the entailment is created, it appears in the Entailment Browser display. 

For Oracle Database, this action is implemented using the PL/SQL SEM_APIS.CREATE_ENTAILMENT procedure. 

–  Remove Entailment Model: Deletes the selected entailment. To select the entailment, click in its row. When 
prompted, confirm that you want to delete the selected entailment. 

For Oracle Database, this action is implemented using the PL/SQL SEM_APIS.DROP_ENTAILMENT procedure. 
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Creating	
  Entailments	
  
To create an entailment, you must select Create Entailment from the Actions menu. 
 

 
 
You will be shown a list of all available models and rulebase, which the current user has access to.  
To create the entailment you must choose the desire models and rulebase by selecting their respective 
checkbox. Selected elements will be display in a list below. 
Regular expressions are supported for the filter. 
 

	
  
	
  

Once you click Create, you will be asked to input a name to save the entailment into the database.  
You will also be given the choice to specify the advanced options.	
  
	
  

	
  
Entailment	
  creation.	
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Advanced	
  entailment	
  creation.	
  

	
  

Deleting	
  Entailments	
  
To delete an entailment, you must select Create Entailment from the Actions menu. 
 

	
  
	
  
You	
  will	
  be	
  asked	
  to	
  confirm	
  before	
  deleting	
  the	
  selected	
  entailment.	
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OWL allows import of the contents of entire ontologies in other ontologies with owl:imports assertion(s).  
Protégé supports owl:imports of ontologies stored in a file system or ones that can be accessed  through a 
valid URL. 
The support for Protégé allows you to import ontologies stored in Oracle Database. 
To reference (ow:imports) an ontology from Oracle Database you must generate the XML catalog, load 
the catalog, specify the ontology name and data source by creating a redirect, and importing the database 
ontology. 
 

Importing	
  an	
  Ontology	
  
In order to import ontologies from Oracle Database you must load the XML Catalog generated by Protégé 
and manually specify the ontology ID and its Datasource. 
 

Generating	
  the	
  XML	
  Catalog	
  
Start Protégé from scratch and save the current ontology into a directory on your local file system without 
making changes to the temporal ontology, then open the saved ontology into the current editor.  
After reloading the saved ontology, a catalog file will be generated in the directory where the ontology 
was saved. 

XML	
  Catalog	
  Structure	
  
The XML catalog file contains the redirects of ontologies that have an ontology IRI that is not the same 
as its physical location or the data source identifier. Below is an example catalog file. 
 
<?xml version="1.0" encoding="UTF-8" standalone="no"?> 
<catalog prefer="public" xmlns="urn:oasis:names:tc:entity:xmlns:xml:catalog"> 
    <uri id="User Edited Redirect" name="urn:N1" uri="jndi-name:oracle-database:N1DS:N1"/> 
</catalog> 
 
You can manually add an entry in the catalog by using the following format 
 
<uri id=”User Edited Redirect” name="[Ontology IRI]" uri="[physical location or data source]"/> 

Loading	
  the	
  XML	
  Catalog	
  
Once you have loaded an ontology you can import one or multiple ontologies from the database by 
selecting Edit ontology libraries option from the File menu. 
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Select the catalog-v001.xml file, which contains the redirects from ontology IDs to physical locations or 
Data Sources. 
 

	
  
After the catalog is loaded you will see the ontology libraries containing the catalog locations and all the 
redirects. 
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Adding	
  an	
  Oracle	
  Database	
  Ontology	
  Data	
  Source	
  Redirect	
  
You can add a redirect by opening the ontology library from the Edit Active Ontology Library option 
from the File menu, and clicking the Add Redirect button. 
 

 
Add	
  Redirect	
  Button	
  

 
The redirect needs to use the Ontology IRI as the Import Declaration and Data Source syntax as follows: 
Note that when adding a new entry to the catalog, there is a known issue in which you must switch focus 
between the text areas in order for the OK button to be enabled. 
 
jndi-name:oracle-database:[Data Source Name]:[Oracle Database Model Name] 
 

 
Data	
  Source	
  Syntax	
  to	
  redirect	
  an	
  ontology	
  to	
  a	
  model	
  stored	
  in	
  	
  Oracle	
  Database	
  	
  

	
  

jndi-name:oracle-nosql:[Data Source Name]:[Oracle Database Model Name] 
 

 
Data	
  Source	
  Syntax	
  to	
  redirect	
  an	
  ontology	
  to	
  a	
  model	
  stored	
  in	
  Oracle	
  NoSQL	
  Database	
  	
  

 

Importing	
  a	
  Database	
  Ontology	
  
Use the Import Wizard, located in the Ontology imports tab and choose Import an ontology that is 
contained in one of the ontology libraries, as shown below 
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Select the ontology to import and Protégé will verify the import. 
 

 
 

After the import has been verified, click Finish to complete the import. 
 

 
 
Once the ontology is imported, the Ontology imports tab will display the name of the imported ontology, 
and all indirect imports if applicable. 
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You	
  will	
  need	
  to	
  input	
  the	
  connection	
  information	
  for	
  the	
  data	
  source	
  specified	
  in	
  the	
  ontology	
  redirect	
  
for	
  ontologies	
  imported	
  from	
  Oracle	
  Database.	
  

	
  
	
  

	
  
“Ontology	
  imports”	
  tab	
  located	
  under	
  the	
  “Active	
  Ontology”	
  tab	
  

	
  
The	
  imported	
  ontologies	
  elements	
  will	
  be	
  displayed	
  using	
  light	
  fonts	
  and	
  the	
  elements	
  belonging	
  to	
  
the	
  ontology	
  will	
  be	
  displayed	
  using	
  bold	
  fonts,	
  as	
  shown	
  below.	
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Removing	
  an	
  Imported	
  Ontology 
To remove an imported Ontology, click the X icon, located to the right of the ontology on the Ontology 
Imports tab. 
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SPARQL contains capabilities for querying required and optional graph patterns along with their 
conjunctions and disjunctions. The SPARQL Query option allows you to query Oracle Database models. 
To execute SPARQL Query’s click Oracle > Execute SPARQL Query. 
 

 
 

 
The SPARQL Query has the following menus and menu items: 
■  Options menu: 

–  Select Model: Selects the model to query. 

–  Attachments: Selects the attachments for a model in Oracle Database (Models and Rulebase’s). 

■  Edit menu: 

–  Copy: Copies the text from the selected elements to the system clipboard. 

–  Copy All: Copies the text from all result rows to the system clipboard. 
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–  Paste: Paste content from the system clipboard into the query input area. 

–  Undo: Undo the last change. 

–  Redo: Redo the last change. 

■  Query menu: 

–  Execute: Executes the current query. 

–  Execute from file: Executes a query from a file. 

–  Example Query: Sets an example query in the input area. 

–  Previous Query: Changes the query into the previous successfully executed one. 

–  Next Query: Changes the query into the next successfully executed one. 
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Selecting	
  Database	
  Models	
  	
  
To select a model, you must select Select Model from the Options menu. 
 
 

 
 
 
A dialog will display all the ontologies that the current user can load from the database. After selecting 
and loading an ontology, the application will display the name of the ontology in the window title bar. 
 
 

 
 
 
Once the model has been selected the user can start executing SPARQL queries. If the user did not 
choose a model and executes a query the application will display the models selection dialog in order to 
execute the query.  
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Selecting	
  Database	
  Attachments	
  	
  
To select attachments, you must select Attachments from the Options menu. 
 
 

 
 
 
You will be shown a list of all available models and rulebase, which the current user has access to.  
To set the attachments you must choose the desire models and rulebase by selecting their respective 
checkbox. Selected elements will be display in a list below. Once selected click select button in order to 
save changes. 
Regular expressions are supported for the filters. 
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Navigating	
  Through	
  Results	
  
After a query is executed the results will be displayed in a table in which URI’s will be displayed using 
prefixes if available or hiding the prefix of the resource if a valid prefix is not found. To display the full 
URI the user can hover the mouse over the cell containing the desire element and the full blown URI will 
be displayed in a tooltip.  
 
 

 
 
 
Results are shown in batches of 250 elements, distributed in 10 pages. To move between the batches of 
data the user needs to use the Next Batch and Previous Batch buttons and to move between the data in a 
batch the user can use the arrow buttons or the dropdown option. 
The complete batch can be displayed by selecting the Show All button. 
 

Generating	
  Queries	
  
After results of a query are displayed, the user can right click a cell and a menu will be displayed showing 
options to copy the full blown URI of the selected resource and an option to create a query that will return 
all information about the selected resource.  
If a user chooses to generate this query, it will be generated in the input area but not executed. 
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Cancel	
  a	
  Long	
  Running	
  Query	
  
Because some applications need to be able to terminate long-running SPARQL queries, a cancel option is 
included in the loading animation.  
 
 

 
 
 

The query will also be terminated from the database side using a unique query ID (qid) value. Using the 
following Oracle prefix can set this ID: 
 
PREFIX ORACLE_SEM_FS_NS: <http://example.com/semtech#qid=8761>  

The qid attribute value is of long integer type. You can choose a value for the qid for a particular query 
based on your own application needs. 
If the user does not specify a qid in the query, the application will automatically generate one for the 
current query. 
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Apache License 
 
Version 2.0, January 2004 
 
http://www.apache.org/licenses/ 
 
TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION 
 
1. Definitions. 
 
"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by 
Sections 1 through 9 of this document. 
 
"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting 
the License. 
 
"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled 
by, or are under common control with that entity. For the purposes of this definition, "control" means (i) 
the power, direct or indirect, to cause the direction or management of such entity, whether by contract or 
otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii) beneficial 
ownership of such entity. 
 
"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this 
License. 
 
"Source" form shall mean the preferred form for making modifications, including but not limited to 
software source code, documentation source, and configuration files. 
 
"Object" form shall mean any form resulting from mechanical transformation or translation of a Source 
form, including but not limited to compiled object code, generated documentation, and conversions to 
other media types. 
 
"Work" shall mean the work of authorship, whether in Source or Object form, made available under the 
License, as indicated by a copyright notice that is included in or attached to the work (an example is 
provided in the Appendix below). 
 
"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived 
from) the Work and for which the editorial revisions, annotations, elaborations, or other modifications 
represent, as a whole, an original work of authorship. For the purposes of this License, Derivative Works 
shall not include works that remain separable from, or merely link (or bind by name) to the interfaces of, 
the Work and Derivative Works thereof. 
 
"Contribution" shall mean any work of authorship, including the original version of the Work and any 
modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to 
Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity authorized 
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to submit on behalf of the copyright owner. For the purposes of this definition, "submitted" means any 
form of electronic, verbal, or written communication sent to the Licensor or its representatives, including 
but not limited to communication on electronic mailing lists, source code control systems, and issue 
tracking systems that are managed by, or on behalf of, the Licensor for the purpose of discussing and 
improving the Work, but excluding communication that is conspicuously marked or otherwise designated 
in writing by the copyright owner as "Not a Contribution." 
 
"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution 
has been received by Licensor and subsequently incorporated within the Work. 
 
2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor 
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable 
copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform, 
sublicense, and distribute the Work and such Derivative Works in Source or Object form. 
 
3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby 
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as 
stated in this section) patent license to make, have made, use, offer to sell, sell, import, and otherwise 
transfer the Work, where such license applies only to those patent claims licensable by such Contributor 
that are necessarily infringed by their Contribution(s) alone or by combination of their Contribution(s) 
with the Work to which such Contribution(s) was submitted. If You institute patent litigation against any 
entity (including a cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution 
incorporated within the Work constitutes direct or contributory patent infringement, then any patent 
licenses granted to You under this License for that Work shall terminate as of the date such litigation is 
filed. 
 
4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in 
any medium, with or without modifications, and in Source or Object form, provided that You meet the 
following conditions: 
 
You must give any other recipients of the Work or Derivative Works a copy of this License; and 
You must cause any modified files to carry prominent notices stating that You changed the files; and 
You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, 
trademark, and attribution notices from the Source form of the Work, excluding those notices that do not 
pertain to any part of the Derivative Works; and 
If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that You 
distribute must include a readable copy of the attribution notices contained within such NOTICE file, 
excluding those notices that do not pertain to any part of the Derivative Works, in at least one of the 
following places: within a NOTICE text file distributed as part of the Derivative Works; within the 
Source form or documentation, if provided along with the Derivative Works; or, within a display 
generated by the Derivative Works, if and wherever such third-party notices normally appear. The 
contents of the NOTICE file are for informational purposes only and do not modify the License. You may 
add Your own attribution notices within Derivative Works that You distribute, alongside or as an 
addendum to the NOTICE text from the Work, provided that such additional attribution notices cannot be 
construed as modifying the License.  
 
You may add Your own copyright statement to Your modifications and may provide additional or 
different license terms and conditions for use, reproduction, or distribution of Your modifications, or for 
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any such Derivative Works as a whole, provided Your use, reproduction, and distribution of the Work 
otherwise complies with the conditions stated in this License. 
5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally 
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of this 
License, without any additional terms or conditions. Notwithstanding the above, nothing herein shall 
supersede or modify the terms of any separate license agreement you may have executed with Licensor 
regarding such Contributions. 
 
6. Trademarks. This License does not grant permission to use the trade names, trademarks, service marks, 
or product names of the Licensor, except as required for reasonable and customary use in describing the 
origin of the Work and reproducing the content of the NOTICE file. 
 
7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides 
the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT 
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without 
limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or 
FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the 
appropriateness of using or redistributing the Work and assume any risks associated with Your exercise 
of permissions under this License. 
 
8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence), 
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent acts) or 
agreed to in writing, shall any Contributor be liable to You for damages, including any direct, indirect, 
special, incidental, or consequential damages of any character arising as a result of this License or out of 
the use or inability to use the Work (including but not limited to damages for loss of goodwill, work 
stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even if 
such Contributor has been advised of the possibility of such damages. 
 
9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works 
thereof, You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or 
other liability obligations and/or rights consistent with this License. However, in accepting such 
obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of any 
other Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for 
any liability incurred by, or claims asserted against, such Contributor by reason of your accepting any 
such warranty or additional liability. 
 
END OF TERMS AND CONDITIONS 
 
APPENDIX: HOW TO APPLY THE APACHE LICENSE TO YOUR WORK 
To apply the Apache License to your work, attach the following boilerplate notice, with the fields 
enclosed by brackets "[]" replaced with your own identifying information. (Don't include the brackets!) 
The text should be enclosed in the appropriate comment syntax for the file format. We also recommend 
that a file or class name and description of purpose be included on the same "printed page" as the 
copyright notice for easier identification within third-party archives. 
 
Copyright [yyyy] [name of copyright owner] 
 
Licensed under the Apache License, Version 2.0 (the "License"); 
you may not use this file except in compliance with the License. 
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You may obtain a copy of the License at 
 
    http://www.apache.org/licenses/LICENSE-2.0 
 
Unless required by applicable law or agreed to in writing, software distributed under the License is 
distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, 
either express or implied. See the License for the specific language governing permissions and limitations 
under the License. 
 
 
 
 


